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Introduction 

The DC4332S/B-DAC is a daughter card used with the Cirrus Logic Dunglass (CDB-PROAUDIO) system to evaluate high 

performance ADC, DAC, and codec devices. This document details how to connect the DC4332S/B-DAC to the Dunglass 

(CDB-PROAUDIO) system and how to get started. 

The DC4332S/B-DAC, with the default jumper positions, is shown in Figure 1. 

 

Figure 1: DC4332S/B-DAC Daughter Card 
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1 Hardware Connections 

The Dunglass system supports interchangeable daughter cards for a variety of ADC, DAC, and codec devices. 

Caution:  

Daughter cards should not be inserted or removed while the Dunglass system is powered. Fully disconnect or power 
down external power supply before changing daughter cards. 

For more information on the Dunglass (CDB-PROAUDIO) system refer to the CDB-PROAUDIO User Guide[1] . 

1.1 How to Connect DC4332S/B-DAC onto the Dunglass System 

The DC4332S/B-DAC is a 4-header daughter card that connects to the Dunglass system using headers DCJ1, DCJ2, 

DCJ3, and DCJ4. A JURA module (described in Section 1.2.1) is also required to be plugged into the Dunglass system. 

To ensure correct connection, the headers are keyed and alignment dots are visible on each board, as shown in Figure 2. 

 

Figure 2: DC4332S/B-DAC Daughter Card and JURA Module Connection to the Dunglass System 

DC4332S/B-DAC  Daughter card
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1.2 USB and Power Connection 

Dunglass is powered using a 5 V external power supply and is controlled via a single USB connection. The JURA module 

supports the following functions via the USB connection: 

• I2C/SPI communications to control device and board 

• Multichannel USB streaming audio (USB Class 2) 

The Dunglass board is provided with a USB-A to USB-C cable and a 5 V wall supply; connection is illustrated in Figure 3. 

 

Figure 3: Dunglass (CDB-PROAUDIO) USB and Power Connection 

A Total Phase Aardvark connector can be used for I2C/SPI communication. Refer to the CDB-PROAUDIO User Guide[1] 

for more details. 

External Power

Supply

+5V, 4A

USB-A to 

USB-C 

CableTo PC or 

MAC
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1.2.1 JURA Module 

The JURA module supports I2C/SPI communication to control the Dunglass system and daughter card; it also enables 

multichannel USB streaming audio (USB audio Class 2). 

The JURA module is connected to the Dunglass board as shown in Figure 4: 

 

Figure 4: JURA Module Connection to Dunglass System 

1.2.2 Dunglass Boot Procedure with JURA Module 

The USB-C cable must be connected between the Dunglass system and the PC or Mac® prior to powering up the board. 

The boot time of the Dunglass system varies depending on the version of firmware on the JURA module but is typically in 

the range of 2 s to 5 s after applying power to the board. 
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1.3 Routing the Digital Audio PCM Signals 

The digital audio PCM paths to the daughter card can be routed from the JURA module, or else from the EXT ASP header 

located on the Dunglass system. The routing is configured using the ASP_SRC1, ASP_SRC2, and ASP_SRC3 headers 

as follows: 

• JURA = Digital audio signals routed from JURA module 

• EXT = Digital audio signals routed from EXT ASP header 

The ASP_SRC1, ASP_SRC2, and ASP_SRC3 headers are configured for JURA Primary Mode, EXT ASP Primary Mode 

and EXT ASP Secondary Mode as shown in Figure 5, Figure 6, and Figure 7 respectively. 

 

The JURA module always operates in Primary Mode – the MCLK, BCLK, and FSYNC clock signals are generated by the 

JURA module as inputs to the daughter card. 

If the digital audio is routed from the EXT ASP header, the direction of the MCLK, BCLK, and FSYNC clock signals are 

configured using the MCLK_SEL, BCLK_SEL, and FS_SEL headers respectively. Each signal is configured 

independently, as follows: 

• IN = EXT_ASP header supports the signal as input to the daughter card 

• OUT = EXT_ASP header supports the signal as output from the daughter card 

Note that the EXT ASP header uses 3.3 V logic levels; a level shifter is incorporated to interface with the VDD_IO domain 

on the DC4332S/B-DAC daughter card. 

Figure 5: JURA Module Primary Mode Figure 6: EXT ASP Primary Mode Figure 7: EXT ASP Secondary Mode 

http://www.cirrus.com/
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1.4 Selection of Hardware or Software Control Mode 

The CS4332S/B supports hardware and software control modes. The hardware and software modes are set via the 

HW/SW SEL header on the DC4332S/B-DAC and the rotary switches on the Dunglass system. The Software Mode and 

Hardware Mode jumper link configurations are shown in Figure 8 and Figure 9. 

• SW = Software Mode 

• HW = Hardware Mode. 

In Hardware Mode, rotary switches are used to select the desired configuration. See Section 4 for information on 

Hardware Mode.  

 

 

Note that Hardware Mode is only supported for VDD_IO = 3.3 V on the DC4332S/B-DAC due to the 3.3 V rotary switch 

pull-up supply on the Dunglass system. 

Figure 8: Software Mode Jumper Link Configuration Figure 9: Hardware Mode Jumper Link Configuration 

http://www.cirrus.com/
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1.5 DC4332S/B-DAC System Clocking Source Selection 

Clocking for the CS4332S/B is provided using either the MCLK input or the crystal (XTAL) oscillator. The MCLK input is 

selected by default on the DC4332S/B-DAC. The XTAL oscillator uses one of two external crystals, Y1 or Y2, provided on 

the DC4332S/B-DAC to generate the system clock. Y1 provides a 22.5792 MHz signal and Y2 provides a 24.576 MHz 

signal.  the oscillators are enabled by configuring resistors on the DC4332S/B-DAC board as follows: 

• Y1 (22.5792 MHz). Enabled by removing R63 and R65, and populating R59 and R61. 

• Y2 (24.576 MHz). Enabled by removing R63 and R65, and populating R62 and R64. 

The clocking source is configured as shown in Figure 10, Figure 11 and Figure 12.  

 

In Hardware Mode, the clocking source is configured using the CONFIG4 pin, as detailed in the CS4332S/B datasheet[2] . 

In Software Mode, the clocking source is selected using the register field SYSCLK_SRC. 

If clocking is provided using the crystal oscillator, the CS4332S/B outputs a clock on the MCLK pin. The frequency of the 

MCLK output clock matches the crystal oscillator frequency. The output clock can be used to drive other devices. 

Figure 10: Dunglass System MCLK 

as clocking source (Default) 

Figure 11: Crystal (XTAL) oscillator 

Y1 as clocking source 
Figure 12: Crystal (XTAL) oscillator 

Y2 as clocking source 
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1.6 DC4332S/B- DAC Output Routing 

The DC4332S/B-DAC board has three routing options for the output of the DAC. The options are configured using P7, 

P11, P13, and P17. The options are as follows: 

• OUT1/OUT2 (Default) – 2 VRMS output on Dunglass OUT1 and OUT2, shown in Figure 14. 

o This is the output of the current-to-voltage buffer/filter contained within the CS4332S/B. 

• LO1/2 – 5 VRMS output on Dunglass OUT3 and OUT4, shown in Figure 13. 

o The output of the current-to-voltage buffer/filter is routed to an op-amp line driver with a gain of +8 dB. 

• HPL/HPR – 1.76 VRMS single-ended headphone output circuit, shown in Figure 15. 

o The output of the current-to-voltage buffer/filter is routed to a single-ended op-amp circuit with a gain of 

- 1.5dB. The output is routed to a 6.3 mm stereo headphone jack (J1).  

o  

 

Figure 14: DAC Output to 

OUT1/OUT2 
Figure 13: DAC Output to 

LOUT1/LOUT2 

Figure 15: DAC Output to 

Headphone Output 
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2 Driver Installation and SoundClear Studio Support 

2.1 SoundClear Studio 

SoundClear® Studio (SCS) is a PC/Mac®-based tool used to configure Cirrus Logic devices. The tools suite provides 

support for evaluation and development and can be used with Dunglass system and associated daughter cards. 

 

Figure 16: SoundClear Studio 

2.1.1 Download SoundClear Studio Software and Drivers 

SoundClear Studio and associated software collateral required for the Dunglass system can be downloaded from 

https://cirrus.com. 

The required components are as follows: 

• SoundClear Studio 2.1. Run the appropriate installer on your Windows® or macOS computer to install SoundClear 

Studio. 

• CS4332S/B SCS Package. Install this in SoundClear Studio to incorporate the CS4332S/B-specific software 

components in SoundClear Studio. See Section 2.2.1 for details on how to install an SCS package. 

• JURA Windows Setup. On Windows computers, run the Cirrus Logic USB Audio Setup to install the driver that 

enables SoundClear Studio to communicate with the JURA board. 

 

http://www.cirrus.com/
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2.2 SoundClear Studio Quick Start Guide 

2.2.1 Installing Packages 

Each daughter card has its own individual SoundClear Studio package that must be installed separately from the main 

SoundClear Studio Software. These are installed from the main menu using "File → Install Package...". Multiple 

packages can be installed together by selecting more than one using the file dialog. 

 

Figure 17: SoundClear Studio – Installing Board Packages 

2.2.2 SoundClear Studio User Guide 

The SoundClear Studio User Guide can be accessed from the main menu using “Help → Open Help Contents..." 

 

Figure 18: SoundClear Studio – User Guide 
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2.2.3 Creating a Virtual System 

A virtual (non-hardware) version of the system can be created using “Systems → Add Virtual System..." 

 

Figure 19: SoundClear Studio – Creating a Virtual System 

This opens a dialog box to select an installed system (shown here is the DC4332S-DAC):  

Figure 20: SoundClear Studio – Adding a Virtual System 

Once created, a virtual system enables the user to interact with virtual versions of the device register map and helper 

panels. 
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2.2.4 Adding an Existing System 

SoundClear Studio automatically detects board hardware such as the Jura module and Cirrus Logic devices. In the event 

of devices not being detected automatically, a device can be added manually. Right click on the system and select “Add 

Device…” 

 

Figure 21: SoundClear Studio – Adding an Existing Device 

Then select the device from those installed, along with the protocol and address of the part (this can be edited again by 

right clicking on the device and selected "Edit Device..."): 

  

Figure 22: SoundClear Studio – Adding an Existing Device 
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2.2.5 Executing SoundClear Studio Scripts 

SoundClear Studio provides the ability to interact with the device register map using Python® scripts. These scripts can 

sequence register operations to configure the desire states, which can then be executed from SoundClear Studio using 

“File→Execute Script…” 

 

Figure 23: SoundClear Studio – Executing Script 

The CS4332 SoundClear Studio package installs a set of scripts to configure the device for common use cases. These 

are available at <User Documents>\Cirrus Logic\SCS\Scripts\<Package Name>. 

The scripts can be accessed via “File→Show User Script Folder→CS4332 Scripts” 

 

Figure 24: SoundClear Studio – Show User Script Folder 
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3 DC4332S/B-DAC Software Mode Quick Start 

The following steps describe how to start the DC4332S/B-DAC in Software Mode after installing the SoundClear Studio 

software and the CS4332 SCS package: 

1. Connect the hardware as shown in Figure 2. 
2. Connect the USB cable to the PC. 
3. Power up the system and ensure the JURA OK, 1.8 V, 3.3 V, and VDD_5V LEDs are illuminated. 
4. Configure signal routing as shown in Section 1.3. 
5. Start SoundClear Studio. 

SoundClear Studio should auto-detect the DC4332S/B-DAC daughter card. If not, follow the procedure 
specified in Section 2.2.4.  

6. Run the required script from the following location: <User Documents>\Cirrus Logic\SCS\Scripts\<Package 
Name>. 

 

http://www.cirrus.com/
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4 Hardware Control Mode 

The Dunglass system supports Hardware Mode for Cirrus Logic high performance ADC, DAC, and codec devices. These 

are supported via the rotary switches on the Dunglass system, as illustrated in Figure 25. 

 

Figure 25: Dunglass Rotary Switches for Hardware Control Mode 

Each switch has silkscreen on the board to indicate the position of the switch. Each switch position enables a pull resistor 

on the respective CONFIG pin to VDD_A or ground, as shown in Figure 26. 

 

Figure 26: Rotary Switch 

If the rotary switches are reconfigured while the Dunglass system is powered, changes will not take effect until the 

DC4332S/B-DAC is reset by pushing the DUT RESET button. 

Note that Hardware Mode is only supported for VDD_IO = 3.3 V on the DC4332S/B-DAC due to the 3.3 V rotary switch 

pull-up supply on the Dunglass system. 

 

http://www.cirrus.com/
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4.1 Hardware Mode Rotary Switch Settings 

The CS4332S/B supports Hardware Mode. The rotary switch functions are described in Table 1 to Table 5. Refer to the 

CS4332S/B datasheet[2] for further details of the Hardware Mode options.  

The CONFIG1 pin selects the ASP operating configuration: 

Table 1: CONFIG1 Hardware Control – ASP Configuration 

Switch  
Position 

Pin Configuration Description 

P1 Pull-up to 3.3 V 0 Ω Software Control Mode (I2C/SPI) 

In I2C Mode, the pull-up resistor is used to select the device address—
see CS4332S/B datasheet. 

In SPI Mode, it is recommended to use the 100 kΩ pull-up position (P4). 

P2 4.7 kΩ 

P3 22 kΩ 

P4 100 kΩ 

P5 Pull-Down to GND 100 kΩ ASP Primary Mode, 176.4 kHz, 192 kHz sample rate 

P6 22 kΩ ASP Primary Mode, 88.2 kHz, 96 kHz sample rate 

P7 4.7 kΩ ASP Primary Mode, 44.1 kHz, 48 kHz sample rate 

P8 0 Ω ASP Secondary Mode, autodetect sample rate1 

P9 No Connection — — 

1. Autodetect sample rate is only supported in MCLK 256 fs(base), MCLK 512 fs(base) or MCLK 1024 fs(base) clocking configurations. 

The CONFIG2 pin selects the ASP format and TDM timeslots option: 

Table 2: CONFIG2 Hardware Control – ASP Configuration 

Switch  
Position 

Pin Configuration Description 

P1 Pull-up to 3.3 V 0 Ω ASP TDM Mode—minimum time slots, ASP_FSYNC_TYPE = pulse 

P2 4.7 kΩ ASP TDM Mode—maximum time slots, ASP_FSYNC_TYPE = pulse 

P3 22 kΩ — 

P4 
100 kΩ ASP TDM Mode—minimum time slots, ASP_FSYNC_TYPE = square 

wave (50% duty cycle) 

P5 
Pull-Down to GND 100 kΩ ASP TDM Mode—maximum time slots, ASP_FSYNC_TYPE = square 

wave (50% duty cycle) 

P6 22 kΩ — 

P7 4.7 kΩ ASP Left-Justified Mode 

P8 0 Ω ASP I2S Mode 

P9 No Connection — — 

The CONFIG3 pin selects the TDM slot selection in TDM Mode: 

Table 3: CONFIG3 Hardware Control – TDM Slot Selection 

Switch  
Position 

Pin Configuration Description 

P1 Pull-up to 3.3 V 0 Ω Slots 14–15 

P2 4.7 kΩ Slots 12–13 

P3 22 kΩ Slots 10–11 

P4 100 kΩ Slots 8–9 

P5 Pull-Down to GND 100 kΩ Slots 6–7 

P6 22 kΩ Slots 4–5 

P7 4.7 kΩ Slots 2–3 

P8 0 Ω Slots 0–1 

P9 No Connection — — 
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The CONFIG4 pin selects the clock reference and ASP channel ordering: 

Table 4: CONFIG4 Hardware Control – Clocking Configuration 

Switch  
Position 

Pin Configuration Clock 
Reference 

Reference Clock 
Frequency (MHz) 

P1 Pull-up to 3.3 V 0 Ω XTAL 1024 fs(base) 1 

P2 4.7 kΩ XTAL 512 fs(base) 

P3 22 kΩ MCLK 1024 fs(base) 

P4 100 kΩ MCLK 512 fs(base) 

P5 Pull-Down to GND 100 kΩ — — 

P6 22 kΩ — — 

P7 4.7 kΩ — — 

P8 0 Ω — — 

P9 No Connection — — — 

1. fs(base) is the base sample rate. 
fs(base) = 48 kHz for 48 kHz-related sample rates; fs(base) = 44.1 kHz for 44.1 kHz-related sample rates. 

The CONFIG5 pin selects the digital filters, note that this feature is only available on the CS4332S DAC: 

Table 5: CONFIG5 Hardware Control – Digital Filter Selection-CS4332S Only 

Switch 
Position 

Pin Configuration DAC Interpolation Filter High-Pass 
Filter (HPF) 32-48 kHz Sample Rate 1 88.2-192 kHz Sample Rate 

P1 Pull-up to 3.3 V 0 Ω Minimum phase, slow roll-off Minimum phase, balanced roll-off Bypassed 

P2 4.7 kΩ Minimum phase, fast roll-off Minimum phase, fast roll-off 

P3 22 kΩ Linear phase, slow roll-off Linear phase, balanced roll-off 

P4 100 kΩ Linear phase, fast roll-off Linear phase, fast roll-off 

P5 Pull-Down to GND 100 kΩ Linear phase, fast roll-off Linear phase, fast roll-off Enabled 

P6 22 kΩ Linear phase, slow roll-off Linear phase, balanced roll-off 

P7 4.7 kΩ Minimum phase, fast roll-off Minimum phase, fast roll-off 

P8 0 Ω Minimum phase, slow roll-off Minimum phase, balanced roll-off 

P9 No Connection — — — — 

1. Fast roll-off filters are supported for all sample rates. Slow roll-off filters are not valid for 16 kHz or 32 kHz sample rate. 

http://www.cirrus.com/
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5 Output Buffer Circuits 

5.1 Output Buffer 

The CS4332S/B incorporates a high-performance sigma-delta current-mode DAC with integrated operational amplifiers 

for current-to-voltage conversion. The external components for the current-to-voltage conversion and out-of-band filtering 

implemented on the DC4332S/B-DAC daughter card are shown in Figure 27. This circuit produces a 2 VRMS differential 

output from a full-scale (0 dBFS) digital input. This output option is selected by selecting OUT1 and OUT2 as shown in 

Figure 14. 

 

Figure 27: Differential Output Buffer 

The feedback resistor, R1 determines the full-scale differential output voltage; a maximum output voltage of 2 VRMS is 

supported at the OUTnN and OUTnP pins. R1 is calculated as follows: 

R1(kΩ) = 
Full-scale output voltage (VRMS)

0.835 mARMS

 = 
2

0.835×10
-3

 = 2.4 kΩ 

The filter is provided by the integrated operational amplifiers and associated feedback components C1 and R1. The 

objective is to provide a flat passband for the audio output bandwidth. The cut-off frequency of the filter is calculated as 

follows: 

FC = 
1

2πR1C1

 = 
1

2π×2400×620×10
-12

 = 107 kHz  

R2 and C2 create an output filter to reduce out-of-band noise of the output. The cut-off frequency of the filter is calculated 

as follows: 

FC = 
1

2πR22C2

 = 
1

2π×100×(2×3.3×10
-9

)
 = 241 kHz 

R3 and C3 form a high-pass filter, which removes the DC bias of the voltage output. The cut-off frequency of the filter is 

calculated as follows: 

FC = 
1

2πR3C3

 = 
1

2π×100×10
3
×220×10

-6
 = 0.007 kHz 

  

620 pF

2.4 kW

100 W

3.3 nF

100 kW

620 pF

100 W

100 kW

2.4 kW

220 µ F

220 µ F

OUTnN

OUTnN_FB

OUTnP

OUTnP_FB

R1

R1

C1

C1 R2

R2

C3

C3

C2
R3

R3

VOUTnP

VOUTnN

http://www.cirrus.com/


 CDB-DC4332S/B-DAC 

 

DS1455DB3 Cirrus Logic   20 
 Copyright © 2025 - 2026 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. 

5.1.1 Active Differential Line Driver Circuit 

Additionally, the DC4332S/B-DAC has an active differential line driver circuit, as shown in Figure 28. This circuit produces 

a 5 VRMS differential output from a full-scale (0 dBFS) digital input. This output option is selected by selecting LO1 and 

LO2 as shown in Figure 13. 

  

Figure 28: Active Differential Line Driver Circuit 

The maximum differential output voltage of CS4332S/B is limited to 2VRMS and is set by the feedback resistor R1. The 

feedback resistor (R1) is determined by the full-scale output voltage as shown in the following equation: 

R1 = 
Max Output Voltage (VRMS)

0.835mARMS

 = 
2

0.835×10
-3

 =  2.4 kΩ 

The anti-alias filter is provided by the integrated op-amp and associated feedback components C1 and R1. The objective 

is to provide a flat passband for the audio output bandwidth. The cut-off frequency of the filter is calculated as follows: 

Fc = 
1

2πR1C1 
= 

1

2×π×2400×620×10
-12

 = 107 kHz 

R2 and C2 create an output filter to reduce out-of-band noise of the output. The cut-off frequency of the filter is calculated 

as follows: 

FC = 
1

2πR22C2

 = 
1

2π×100×(2×3.3×10
-9

)
 = 241 kHz 

C3 removes the DC bias of the CS4332S output and forms a high pass filter with parallel resistance of R3 and R4. The 

cut-off frequency of the filter is calculated as follows:  

FC = 
1

2π(R
3
||R4)C3

 = 
1

2×π × (
100×10

3
×4.7×10

3

100×10
3
+4.7×10

3) ×100×10
-6

 = 0.35 Hz 

R4 and C4 create a low pass filter. The cut-off frequency of the filter is calculated as follows: 

FC = 
1

2πR42C4

= 
1

2×π×4.7×10
3
 ×2×200×10

-9
 = 84.7 kHz  

  

620 pF

2.4 kW

100 W

3.3 nF

100 kW

12.1 kW

3.3 nF

–

+

+

–

200 pF

620 pF

100 W

100 kW

2.4 kW

100 µ F

100 µ F 4.7 kW

4.7 kW

100 W

120 pF

12.1 kW

100 W

120 pF

VOUTnN

VOUTnP

OUTnN

OUTnN_FB

OUTnP

OUTnP_FB

R1

R1

C1

C1 R2

R2

C3

C3

C2
R3

R3

R4

C4

R4

R5

C5

C5

R5

R6

R6

C6
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R5 and C5 create a low pass filter within the OPAMP feedback loop. The cut-off frequency of the filter is calculated as 

follows: 

FC = 
1

2πR5C5

 = 
1

2×π×12.1×10
3
×120×10

-9
 = 109.6 kHz  

The gain of the output buffer is determined by the ratio R4 and R5.  

Gain = 
R5

R4

 = 
12.1×10

3

4.7×10
3

= 2.6  

R7 and C6 limit the output current, prevents load capacitance from making the circuit unstable and filters any out of band 

noise intruded by the OPAMP. The cut-off frequency of the filter is calculated as follows: 

FC = 
1

2πR72C6

 =  
1

2×π×100×2 ×3.3×10
-9

 = 241.1 kHz 

5.1.2 Active Differential to Single Ended Circuit 

The DC4332S/B-DAC has a 6.3 mm stereo headphone jack that is controlled by an active differential-to-single-ended circuit, 
as shown in Figure 29. This circuit produces a 1.7 VRMS differential output from a full-scale (0 dBFS) digital input. This output 
option is selected by selecting HPR and HPL as shown in Figure 15. 

 

Figure 29 Active Differential to Single Ended Circuit 

The maximum differential output voltage of CS4332S/B is limited to 2VRMS and is set by the feedback resistor R1. The 

feedback resistor (R1) is determined by the full-scale output voltage as shown in the following equation: 

R1 = 
Max Output Voltage (VRMS)

0.835mARMS

 = 
2

0.835×10
-3

 =  2.4 kΩ 

The anti-alias filter is provided by the integrated op-amp and associated feedback components C1 and R1. The objective 

is to provide a flat passband for the audio output bandwidth. The cut-off frequency of the filter is calculated as follows: 

Fc = 
1

2πR1C1

 = 
1

2×π×2400×620×10
-12

 = 107 kHz 

R2 and C2 create an output filter to reduce out-of-band noise of the output. The cut-off frequency of the filter is calculated 

as follows: 

FC = 
1

2πR22C2

 = 
1

2π×100×(2×3.3×10
-9

)
 = 241 kHz 
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R4, R5 and C3 create a low pass filter within the OPAMP feedback loop. The cut-off frequency of the filter is calculated as 

follows: 

FC = 
1

2π(R4+R5)C3

 = 
1

2×π×(5.1×10
3
+1×10

3)×120×10
-9

 = 217.4 kHz  

The gain of the output buffer is determined by the ratio R3 and R4.  

Gain = 
R4

R3

 = 
5.1×10

3

7.5×10
3

 = 0.68  

R7, R8, R9, C6 and C7 remove the DC bias of the CS4332S output, limit the output current, ensure stability of the output, 

and filter any out-of-band noise introduced by the operation amplifiers. 

The cut-off frequency of the high-pass filter is calculated as follows: 

FC = 
1

2π(R8+R9)C7

 = 
1

2×π×(560+100×10
3)×47×10

-6
 = 0.03 Hz 

The cut-off frequency of the low-pass filter is calculated as follows: 

FC = 
1

2πR7C6 
= 

1

2×π×100×1.8×10
-9

 = 884.2 Hz 
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6 Notices 

JURA firmware development utilizes components under the following licenses: 

1. XMOS PUBLIC LICENCE: Version 1, available at www.xmos.ai/license-agreements/ 

2. The MIT License, available at www.github.com/microsoft/uf2/blob/master/LICENSE.txt. Copyright © Microsoft 

Corporation 

Unmodified USB Audio 2.0 Device Software source code is available from www.xmos.ai under XMOS PUBLIC LICENCE: 

Version 1. 

7 References 

[1]  Cirrus Logic, CDB-PROAUDIO_DS1352DB; Dunglass System (CDB-PROAUDIO) 

[2]  Cirrus Logic, CS4332S_DS1432; High Performance Two-Channel Audio DAC Datasheet 

[3]  Cirrus Logic, CS4332B_DS1431; High Performance Two-Channel Audio DAC Datasheet 
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Contacting Cirrus Logic Support 

For all product questions and inquiries, contact a Cirrus Logic Sales Representative.  

To find the one nearest you, go to www.cirrus.com. 

IMPORTANT NOTICE 

The products and services of Cirrus Logic International (UK) Limited; Cirrus Logic, Inc.; and other companies in the Cirrus Logic group (collectively 

either “Cirrus Logic” or “Cirrus”) are sold subject to Cirrus Logic’s terms and conditions of sale supplied at the time of order acknowledgment, 

including those pertaining to warranty, indemnification, and limitation of liability. Software is provided pursuant to applicable license terms. Cirrus 

Logic reserves the right to make changes to its products and specifications or to discontinue any product or service without notice. Customers should 

therefore obtain the latest version of relevant information from Cirrus Logic to verify that the information is current and complete. Testing and other 

quality control techniques are utilized to the extent Cirrus Logic deems necessary. Specific testing of all parameters of each device is not necessarily 

performed. In order to minimize risks associated with customer applications, the customer must use adequate design and operating safeguards to 

minimize inherent or procedural hazards. Cirrus Logic is not liable for applications assistance or customer product design. The customer is solely 

responsible for its overall product design, end-use applications, and system security, including the specific manner in which it uses Cirrus Logic 

components. Certain uses or product designs may require an intellectual property license from a third party. Features and operations described 

herein are for illustrative purposes only and do not constitute a suggestion or instruction to adopt a particular product design or a particular mode of 

operation for a Cirrus Logic component. 

CIRRUS LOGIC PRODUCTS ARE NOT DESIGNED, TESTED, INTENDED OR WARRANTED FOR USE (1) WITH OR IN IMPLANTABLE 

PRODUCTS  OR FDA/MHRA CLASS III (OR EQUIVALENT CLASSIFICATION) MEDICAL DEVICES, OR (2) IN ANY PRODUCTS, APPLICATIONS 

OR SYSTEMS, INCLUDING WITHOUT LIMITATION LIFE-CRITICAL MEDICAL EQUIPMENT OR SAFETY OR SECURITY EQUIPMENT, WHERE 

MALFUNCTION OF THE PRODUCT COULD CAUSE PERSONAL INJURY, DEATH, SEVERE PROPERTY DAMAGE OR SEVERE 

ENVIRONMENTAL HARM. INCLUSION OF CIRRUS LOGIC PRODUCTS IN SUCH APPLICATIONS IS UNDERSTOOD TO BE FULLY AT THE 

CUSTOMER’S RISK AND CIRRUS LOGIC DISCLAIMS AND MAKES NO WARRANTY, EXPRESS, STATUTORY OR IMPLIED, INCLUDING THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE, WITH REGARD TO ANY CIRRUS LOGIC PRODUCT THAT IS USED 

IN SUCH A MANNER. IF THE CUSTOMER OR CUSTOMER’S CUSTOMER USES OR PERMITS THE USE OF CIRRUS LOGIC PRODUCTS IN SUCH A 

MANNER, CUSTOMER AGREES, BY SUCH USE, TO FULLY INDEMNIFY CIRRUS LOGIC, ITS OFFICERS, DIRECTORS, EMPLOYEES, DISTRIBUTORS 

AND OTHER AGENTS FROM ANY AND ALL LIABILITY, INCLUDING ATTORNEYS’ FEES AND COSTS, THAT MAY RESULT FROM OR ARISE IN 

CONNECTION WITH THESE USES. 

This document is the property of Cirrus Logic, and you may not use this document in connection with any legal analysis concerning Cirrus Logic 

products described herein. No license to any technology or intellectual property right of Cirrus Logic or any third party is granted herein, including but 

not limited to any patent right, copyright, mask work right, or other intellectual property rights. Any provision or publication of any third party’s products 

or services does not constitute Cirrus Logic’s approval, license, warranty or endorsement thereof. Cirrus Logic gives consent for copies to be made of 

the information contained herein only for use within your organization with respect to Cirrus Logic integrated circuits or other products of Cirrus Logic, 

and only if the reproduction is without alteration and is accompanied by all associated copyright, proprietary and other notices and conditions 

(including this notice). This consent does not extend to other copying such as copying for general distribution, advertising or promotional purposes, or 

for creating any work for resale. This document and its information is provided “AS IS” without warranty of any kind (express or implied). All statutory 

warranties and conditions are excluded to the fullest extent possible. No responsibility is assumed by Cirrus Logic for the use of information herein, 

including use of this information as the basis for manufacture or sale of any items, or for infringement of patents or other rights of third parties. Cirrus 

Logic, Cirrus, the Cirrus Logic logo design, and SoundClear are among the trademarks of Cirrus Logic. Other brand and product names may be 

trademarks or service marks of their respective owners. 

Copyright © 2025 - 2026 Cirrus Logic, Inc. and Cirrus Logic International Semiconductor Ltd. All rights reserved. 

http://www.cirrus.com/
http://www.cirrus.com/

